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This job aid is available online: 

• The Public Folders:  

All Public Folders > Statewide > Connections > Build 15 

• The CONNECTIONS Intranet site: 

DFA Intranet Site > OCFS Homepage > Connections > Desk and Job Aids 
 

The CONNECTIONS Intranet site also contains information about CONNECTIONS 
training. 

 

 

Note: New Phone Number for the Help Desk 
The CONNECTIONS Help Desk staff are available to answer basic questions related to 
your equipment, or problems you’re having with the CONNECTIONS application. If they 
cannot solve your problem, they will record your information and forward it to others who 
can. 

When you call the Help Desk with a problem, you will be given a ticket number to use for 
tracking your issue and its resolution. Keep a record of this number; you will need it for 
any follow-up conversations with the Help Desk. 

The Help Desk is staffed 24 hours a day, seven days a week. The new telephone 
number is: 

1-800-697-1323 
 

 

Note: Any visible identifying data in examples in this job aid is simulated. 
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I - Introduction 

CONNECTIONS provides a tool for workers to manage information related to their work 
with children, families, and Foster/Adoptive homes and to save it for future reference. 
This documentation facilitates the management of caseloads and provides an historical 
record of information about each case. 

In addition to using CONNECTIONS to manage and access caseload information, 
workers need to be able to use the CONNECTIONS system to record case notes and 
narratives in an organized manner that promotes quality casework practice. This ability 
will not only aid the worker in his/her casework, it will also aid supervisors and managers 
in their review and approval of cases. 

The Foster and Adoptive Home Record Summary (FRS) provides a comprehensive view 
of FAD information that has been recorded in CONNECTIONS, including home 
demographics, person detail and licensing information. A single, multi-tabbed window 
allows workers to access, view, and print FAD home information easily. The window is 
organized to be consistent with the existing foster/adoptive home development process. 
The FRS allows workers to record comments and contact notes at appropriate points 
throughout this process. 

Note: Although the FRS allows you to view case information conveniently, not all of the 
information you see in the FRS can be updated through the FRS. Much of the 
information presented in the FRS is drawn from other CONNECTIONS windows and can 
only be updated in those windows. However, most tabs (Home Demographics, 
Licensing Information, Household Member Detail, Home Study Narrative, Annual 
Reauthorization Narrative, FAD Checklist, and Contacts) do allow for the recording of 
various types of comments and notes and, in the case of the Home Study and Annual 
Reauthorization tabs, creation and editing of narratives directly within the FRS. 

Note: Home Study narratives that existed prior to Build 15 will be converted and 
available for reference through the Event List. They will be labeled, “Converted Pre Build 
15 Home Study.”  Reauthorization narratives will continue to be available through the 
event list as they have always been. These narratives can be copied and pasted into the 
FRS Home Study Narrative and Annual Reauthorization Narrative using the methods 
described in the Copy and Paste Guidelines on page 49. If the Pre Build 15 Home Study 
narrative was in process, but not submitted to the supervisor at the time of the 
conversion, it will be necessary to copy this information into the FRS Narrative. If the 
former narrative is in Pending-Approval status, it will be brought over and included at the 
end of the FRS Narrative.  

Features or the FRS include: 

• Mechanisms for recording FAD Home Study narratives and Annual 
Reauthorization narratives. These procedures replace the current Home Study 
and Reauthorization procedures.  

Using the FRS to create these narratives eliminates the need for duplicate entry 
of information into external notes documents and CONNECTIONS. This will result 
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in a more complete, on-line record for each home and an improvement in the 
quality of case record documentation for FAD homes.  

It is important to realize that each time a new Home Study or Reauthorization is 
initiated a new FRS is created, but only one active FRS will exist at any particular 
time. The result is that more than one FRS will exist in CONNECTIONS for a 
particular home.  

• OCFS templates will be provided for recording these narratives.  

A major advantage of the new Home Study template is the elimination of the 
freezing of Section 1 of the Home Study document the first time the Home Study 
is approved by a supervisor. This would prevent any updating of the home’s 
demographic information in this section. The introduction of the FRS with its new 
Home Study template provides the ability to update home demographic 
information in the narrative as needed. 

Note: When talking about the narrative documents, it is important to understand 
the difference between a template and a document. Think of the template as an 
empty “form.” To create a narrative, you open the template and enter information 
into the form to create a document. You then save the document. The blank 
template does not change. 

• The FAD checklist - This updateable checklist will assist in verifying that all tasks 
necessary for proper certification and authorization of Foster and Adoptive homes 
have been completed. 

• The Contacts tab – This provides a place for workers to record all contacts made 
for a home, creating a contemporaneous document.  

• Supervisors can use the FRS to review home information, Home Study and 
Reauthorization narratives, and contacts notes. 

• One noticeable benefit for you, the worker, is the ability to view important and 
useful information in one place without having to navigate through multiple 
windows in CONNECTIONS. 

 

II - Accessing the FRS 

The FRS can be accessed in two ways, through the Task List and through the Event 
List. 

 

 

 

Security for the FRS 
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Any worker who can access a FAD Home from their workload can access the FRS via 
the Home Study, Annual Reauthorization or View FAD Record Summary tasks on 
the Task List. 

Workers (with the proper FAD security) from the agency that authorizes and approves 
the home will have access to in-process or historical (frozen) FRS information. 

 

Accessing the FRS from the Task List  

1. In the Assigned Workload window, select a FAD home and click the Tasks 
button to open the Task List.  

2. The FAD Task List contains three new tasks:  

 
 

a. Home Study - This task provides access for viewing and updating 
information for the home and the ability to create and update Home Study 
narratives.  

b. Annual Reauthorization – This task provides access for viewing and 
updating information for the home and the ability to update Home Study 
narratives and complete the Annual Reauthorization process. It replaces 
the Reauthorization task that previously appeared on the FAD Task List. 
(This task is only available during the 90 days prior to the home’s 
certification or approval due date.) 

c. View FAD Record Summary – This task provides view-only access to 
information and any existing Home Study or Annual Reauthorization 
narratives for the home. 

Note: Which buttons on the Task List window are used to open the FRS will depend 
on the specific task to be accomplished and the circumstances in which the FRS is 
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being accessed. These factors are explained in “The FAD Recording Process Using 
the FRS” on page 34. 
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Accessing the Home Study and Annual Reauthorization from the Event List  

Home Study and Annual Reauthorization narratives create navigable events that appear 
in the Event List.   

 
 

The Status column for the Home Study and Annual Reauthorization events will display 
one of four states: PROC, PEND, APRV, and REJT. Conditions for changes in the 
Status of Events are covered in “Events Created by the FRS” on page 47. 

Events with a status of PROC, PEND, or REJT allow view-only access to the FRS. 

Events with a status of APRV allow access to frozen/approved Home Study or 
Reauthorization documents. 

After clicking on the event to select it, clicking on the Detail button will open the FRS in 
view-only mode.  
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III – The Layout of the FRS 

For the purposes of this explanation, think of the FRS window as being organized into 
three sections. The Heading and Button sections contain elements that are present no 
matter which section of the FRS is being used. The Tabs are the sections that make up 
the main body of the FRS and are described in detail below. 

 

1 – The Heading 
The heading is always present when the FRS is open. It includes the following 
information: Resource Name, Resource ID, Authorized From Date, Authorized To Date, 
Vendor ID, and Agency Name/Resource ID. 

2 – The Buttons 
The buttons are always present when the FRS is open. The following buttons appear at 
the bottom of the FRS window: 

Submit: This button initiates the Save and Submit process. Clicking it opens the F/A 
Home License window, allowing workers to Save and Submit the FRS and the Home 
license information together. 

This button will be disabled if the FRS has been entered in view-only mode or if no 
information has been saved to the FRS. 

 

CONNECTIONS - System Build 15 – FRS –04/12/02 Page 9 

 



 

Help on Narratives: Clicking on this button allows you to access help information on 
how to use the Home Study and Annual Reauthorization documents. If you click on the 
Help on Narratives button while on the Home Study or Annual Reauthorization tabs, 
you will open help information about that document. (Clicking on the button while on any 
other tab will open an index of help topics relating to these narratives.)  

This separate help is made available to provide information on completing the narrative 
documents. [If you click on Help on the menu bar of the Word narrative document, you 
will be accessing Help for Microsoft Word rather than Help on how to use the Home 
Study or Annual Reauthorization documents.] 

• To learn about the Help information available for the rest of the FRS, see “FRS 
Online Help” on page 31. 

Generate Report: Clicking on this button will open the Generate Report window. This 
window allows you to choose any or all of the FRS tabs to be formatted into a single 
document that can be printed. Details of the Generate Report window are described in 
“Printing the FRS” on page 33. 

Close: Clicking on this button will close the FRS and return you to the window from 
which you entered the FRS, either the Task List window or the Event List window. 

 

3 - The Tabs 

3a – Overview  
 

 
 

The information contained in the FRS is organized into sections, which are represented 
by file tabs on the FRS window. Appearing from left to right, these tabs are labeled:  

1. Home Demographics (abbreviated as “Home Demo.”) 

2. Licensing Information 

3. Household Member Detail 

4. Home History Events 

 

CONNECTIONS - System Build 15 – FRS –04/12/02 Page 10 

 



 

5. Agency/Worker Information (abbreviated as “Agy./Worker Information”) 

6. Home Study Narrative 

7. Annual Reauthorization Narrative (abbreviated as “Annual Reauth. Narrative”) 

8. FAD Checklist 

9. Contacts 

The information in any of the tabs can be accessed by clicking directly on that tab in the 
FRS window. Tabs can be accessed in any order. 

As described in the sections that follow, the Home History Events and Agency/Worker 
Information tabs only display information that has been recorded in other 
CONNECTIONS windows. You cannot update this information while in the FRS. To 
update this information, you must click on the Close button on the FRS, which returns 
you to the Task List or Event List window. 

While the remaining tabs (Home Demographics, Licensing Information, Household 
Member Detail, Home Study Narrative, Annual Reauthorization Narrative, FAD 
Checklist, and Contacts) also display information that must be updated in other 
CONNECTIONS windows, these tabs also allow the recording of various types of 
information, comments, and notes and, in the case of the Home Study and Annual 
Reauthorization tabs, creation and editing of narratives directly within the FRS. 

Note: The FRS contains information drawn from several other windows in 
CONNECTIONS (Home Demographics, F/A Home License, Person Detail). These 
windows have undergone changes as a result of B15. For details on modifications to 
these windows, see the Build 15 FAD Job Aid. 

Information entered in the FRS will be stored in the CONNECTIONS database.  When 
you reenter the FRS, it will be “refreshed” with the most current information from the 
CONNECTIONS database. This information can be reviewed and, if necessary, updated 
further. 
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3b – Home Demographics Tab 
 

 
 

The Home Demographics tab will be the active tab whenever the FRS is entered via 
the Home Study or View FAD Record Summary tasks in the Task List. 

This tab contains demographic information taken from the Home Demographics window. 
The upper section includes: Home Name, Legal Name, Authorizing Agency, Sub 
Agency, Respite, Setting, Status, Source of Inquiry, Marital Status, Language, Religion, 
Ethnicity/Ethnic Origin, and Race. The grid in the lower section lists both Primary and 
Business address and phone number information. The default sort for information in this 
grid is by “Address Type” with the Primary Address being listed first. The grid can be 
resorted by any column by clicking on the heading of that column. The “Resource Lien 
Filed” checkbox will display a check if a Resource Lien has been filed.  

The information you view in the Home Demographics tab cannot be updated from 
within the FRS. To update the information in this tab, you must close the FRS window 
and then open the appropriate CONNECTIONS window(s).  
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Buttons 

The Home Demographics tab also contains two buttons: 

Emergency Backup: Clicking this button opens a separate comments box for entering 
information on the persons to be contacted in an emergency situation if the foster 
parents cannot be reached. This information will be saved to the database. The 
checkbox next to the Emergency Backup button will automatically be checked when 
comments have been entered and saved to the database. 

 
 

Directions to the Home: Clicking this button opens a separate comments box for 
entering directions to the home. This information will be saved to the database. The 
checkbox next to the Directions to the Home button will automatically be checked 
when comments have been entered and saved to the database. 

 
 

The Emergency Backup and Directions to the Home windows each contains three 
buttons: Spell Check, Save, and Cancel. The Save button saves the newly entered 
information to the CONNECTIONS database and a Cancel button deletes that 
information. Clicking Save or Cancel closes the window and returns you to the Home 
Demographics tab. 
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3c – Licensing Information Tab 
 

 
 

This tab displays information taken from the F/A Home License window. The upper 
section includes Setting, Facility Type (previously titled LOC), Status, and Program 
Types.  

The “Anticipated Authorization Period Upon Approval” section appears on this tab when 
the FRS is entered via the Annual Reauthorization task. The dates that appear here are 
system-calculated and indicate what the new certification or approval period will be upon 
approval.  

The center portion of the tab displays the Approved Male and Female Age Ranges. 
Underneath those fields is the Placement Information for Capacity and Open Slots. 

The information you view in the Licensing Information tab cannot be updated from within 
the FRS. To update the information in this tab, you must close the FRS window and then 
open the appropriate CONNECTIONS window(s).  
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Buttons 

The Licensing Information tab also contains two buttons that open windows for 
recording child characteristics that foster parents have identified for potential child 
placements: 

Child Characteristics: Clicking this button opens a separate comments box for entering 
information on Child Characteristics Accepted. This information is saved to the 
database. The checkbox next to the Child Characteristics button will automatically be 
checked when comments have been entered and saved to the database. 

 
Child Race/Eth/Rel/Languages: Clicking this button opens the Child Race, Ethnicities, 
Religions and Languages window, a separate comments box for entering child races, 
ethnicities, religions, and languages. This information is saved to the database. The 
checkbox next to the Child Race/Eth/Rel/Languages button will automatically be 
checked when comments have been entered and saved to the database. 

 
The Child Race, Ethnicities, Religions and Languages window contains three buttons: 
Spell Check, Save, and Cancel. The Save button saves the newly entered information 
to the CONNECTIONS database and a Cancel button deletes that information. Clicking 
Save or Cancel closes the window and returns you to the Licensing Information tab. 

 

CONNECTIONS - System Build 15 – FRS –04/12/02 Page 15 

 



 

 

3d – Household Member Detail Tab 
 

 
This tab displays information taken from the Person Detail window and it includes 2 
grids. 

Upper Grid 

The upper grid includes the following information for each household member: Name, 
Sex, Date Of Birth, Age, Language, Religion, Marital Status, Ethnicity, Race, 
Relationship/Interest, and Date the Person was Added to the FAD home. 

When one of the people in the upper grid is selected (by clicking on their line), an arrow 
will appear to the left of their name. A similar arrow will appear to the left of one of the 
lines in the lower grid. This makes it clear which line of information in the lower grid 
applies to which person in the upper grid.  

Lower Grid 

The lower grid contains the following information for each household member: Medical 
Exam Date, Fingerprint Cards Sent Date, Fingerprint Cards Received Date, 
Fingerprint Results, Safety Assessment Date, SCR Database Check Sent, SCR 
Database Check Received, and SCR Results.  

The information in the last five of these columns can ONLY be updated in the FRS: 
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Fingerprint Results: Clicking in this cell of the grid for the selected person opens a drop 
down box with the following choices: 

1. No Record Found  

2. Presumptive Disqualification 

3. Discretionary Disqualifier 

4. Hold in Abeyance 

Note: If option 2, 3, or 4 is chosen, the following message will display: 

“Option selected for Fingerprint Results requires a Safety Assessment.” 

Safety Assessment Date, SCR Database Check Sent, and SCR Database Check 
Received: In each of these columns, the date in question can be entered directly into 
the grid by clicking in the cell on the grid and typing the date directly into the cell.  

SCR Results: Clicking in this cell for the selected person opens a drop down box with 
the following choices: 

1. No Record Found 

2. Record Found 

Once information is entered into any cell in the lower grid the Save button is used to 
save the information to the database. The Cancel button is used to move from this grid 
to other parts of the FRS without saving information. 

With the exception of the columns mentioned above, the information you view in the 
Household Member Detail tab cannot be updated from within the FRS. To update the 
information in this tab, you must close the FRS window and then open the appropriate 
CONNECTIONS window(s).  

Buttons 

A.K.A. Names, Person ID, Case List, Person Detail FA, and Training Details: 
Additional information on Household Members is available through these buttons that 
appear at the bottom of the Household Member Detail tab. 

1. Select a person by clicking their name in the upper grid.  

2. Click one of the buttons listed above to retrieve that information for the selected 
individual.  

Note: These buttons will always be active. If a particular button’s information has not 
been entered into CONNECTIONS for the highlighted person, clicking the button will 
display a pop up window with the message “No Data Available.” 

Safety Assessment Template: This button opens the Safety Assessment template in a 
separate Word window. A Safety Assessment should be completed when a fingerprint 
check returns a result of anything other than “No Record Found.”  
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Training Comments: Clicking this button opens a separate comments box for entering 
comments on training taken by the person selected in the upper grid of the Household 
Member Detail tab. This information is saved to the database. The checkbox next to the 
Training Comments button will automatically be checked when comments have been 
entered and saved to the database for the person selected in the upper grid. 

 
 

Med/CHRC and SCR Comments: Clicking this button opens a separate comments box 
with three sections. The upper section is for Medical comments, the middle section is for 
comments on the Criminal History Record Check (CHRC), and the lower section is for 
additional information pertaining to the results of the SCR clearance check on the 
person selected in the upper grid of the Household Member Detail tab. This information 
is saved to the database. The checkbox next to the Med/CHRC and SCR Comments 
button will automatically be checked when comments have been entered and saved to 
the database for the person selected in the upper grid. 
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Employment Comments: Clicking this button opens the Current Source of Income and 
Details window, a separate comments box for entering additional information on the 
employment and income of the person selected in the upper grid of the Household 
Member Detail tab. This information is saved to the database. The checkbox next to the 
Employment Comments button will automatically be checked when comments have 
been entered and saved to the database for the person selected in the upper grid. 

 
 

The Training Comments, Med/CHRC and SCR Comments, and Current Source of 
Income and Details windows each contains three buttons: Spell Check, Save, and 
Cancel. The Save button saves the newly entered information to the CONNECTIONS 
database and a Cancel button deletes that information. Clicking Save or Cancel closes 
the window and returns you to the Household Member Detail tab. 
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3e – Home History Events Tab 
 

 
This tab will list certain events that relate to the history of the home, including all 
approvable events and any assignment events where the agency or sub-agency has 
changed. The following information is listed for each event: Event Date, TX Date 
(System Transmission Date), Event Status, Event Type, and Event Description. 

Note: Although the titles are similar, the Home History Events tab of the FRS does not 
display the same information as the F/A Home History window found elsewhere in 
CONNECTIONS (accessed through the View Home History task on the FAD Task List.) 

The information you view in the Home History Events tab cannot be updated within the 
FRS.  
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3f – Agency/Worker Information Tab 
 

 
This tab lists the following information for all current workers assigned to the home: 
Worker Role, Worker Name, Worker Phone, Agency Name, Agency Code, Agency 
Resource ID, Unit, Site, and Agency Phone. 

The information you view in the Agency/Worker Information tab cannot be updated from 
within the FRS. To update the information in this tab, you must close the FRS window 
and follow the process for reassigning the home.  
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3g – Home Study Narrative Tab 
 

 
With the introduction of the FAD Record Summary process, the FRS becomes the 
primary mechanism for the creation and updating of Home Study Narratives. (The Home 
Study button and checkbox have been removed from the Home License window.)  

The Home Study Narrative tab provides for the indication of the reason(s) for the Home 
Study. Choices include “Initial Home Study”, “Reopen a Home”, “Agency Transfer”, and 
a list of reasons for an “Interim Home Study.” (Interim Home Study reasons are changes 
to the home that don’t affect the home’s “from/to” certification dates.) More than one 
reason can be selected. The selected reason(s) will be displayed on the printed Home 
Study Narrative. A Save button saves the selected reason(s) to the CONNECTIONS 
database and a Cancel button cancels the choice. 

The Home Study Narrative tab also provides access to a choice of two Home Study 
narrative templates: The OCFS Standard Home Study and the GPS/MAPP Home Study. 
Choose the Home Study template required by your agency’s local procedures. (An 
option for selecting a locally produced Home Study template is visible but is disabled 
until a future implementation.) Home Study narratives that existed prior to Build 15 will 
be converted and available for reference through the Event List. These narratives can be 
copied and pasted into the FRS Home Study Narrative using the methods described in 
the Copy and Paste Guidelines on page 49. 
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The Retrieve/Edit Narrative button opens the selected Home Study in a separate Word 
document. Whether this document contains previously entered material and whether 
those entries are editable depends on the task through which the FRS was entered and 
the circumstances under which the narrative was opened. These conditions are 
described in “The FAD Recording Process Using the FRS” on page 34. 

 

Help On Narratives 

You can access help information about how to use the Home Study Narrative by clicking 
on the Help on Narratives button at the bottom of the FRS window. 

 
It’s important to realize that the Help on Narratives button is hidden when you click on 
the Retrieve/Edit Narrative button because this opens the Word document, which 
covers the FRS window. The Help on Narratives button is visible when you close or 
minimize the narrative document. (See “Closing or Minimizing the Home Study 
Narrative” on page 24.) 

 

CONNECTIONS - System Build 15 – FRS –04/12/02 Page 23 

 



 

When you click the Help on Narratives button while the Home Study Narrative tab is 
open, you will access Help information on using the Home Study Narrative.  

 
 

Closing and Minimizing the Home Study Narrative  

You can close the Home Study Narrative by clicking on the File drop down menu and 
selecting Close. Alternatively, you can click on the Close window button in the upper 
right corner of the Word document window. Either method will save the narrative to the 
CONNECTIONS database and return you to the Home Study tab with the Retrieve/Edit 
Narrative button visible.  

 
 

Rather than closing the document, you can minimize it using the Minimize button in the 
upper right hand corner of the Word document window.  

To re-open a minimized document, click on either the document’s Task Bar button at the 
bottom of the screen or the Retrieve/Edit button on the Home Study Narrative tab. 

Note: Be sure to save your narrative before minimizing since minimizing does not save 
your work. 
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3h – Annual Reauthorization Narrative Tab  
 

 
 

The Annual Reauthorization tab will be the active tab whenever the FRS is entered via 
the Annual Reauthorization task in the Task List. 

Note: The Annual Reauthorization Task is only available on the Task List during the 90 
days prior to the home’s certification or approval due date. At all other times, all 
pushbuttons on the Task List are disabled when the Annual Reauthorization task is 
selected. 

With the introduction of the FAD Record Summary process, the FRS becomes the 
primary mechanism for the creation and updating of Annual Reauthorization Narratives. 
Annual Reauthorization narratives that existed prior to Build 15 will be available for 
reference through the Event List as they have been in the past. These narratives can be 
copied and pasted into the FRS Annual Reauthorization Narrative using the methods 
described in the Copy and Paste Guidelines on page 49. The FRS will provide an OCFS 
template into which information can be entered. An option for selecting a locally 
produced Annual Reauthorization template is visible but is disabled until a future 
implementation. 
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The Retrieve/Edit Narrative button opens the selected Reauthorization narrative in a 
separate Word document. Whether this document contains previously entered material 
and whether those entries are editable depends on the task through which the FRS was 
entered and the circumstances under which the narrative was opened. These conditions 
are described in “The FAD Recording Process Using the FRS” on page 34.  

 

Help On Narratives 

You can access help information about how to use the Annual Reauthorization Narrative 
by clicking on the Help on Narratives button at the bottom of the FRS window. 

 
It’s important to realize that the Help on Narratives button is hidden when you click on 
the Retrieve/Edit Narrative button because this opens the Word document, which 
covers the FRS window. The Help on Narratives button is visible when you close or 
minimize the narrative document. (See “Closing or Minimizing the Annual 
Reauthorization Narrative” on page 27.) 
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When you click the Help on Narratives button while the Annual Reauthorization 
Narrative tab is open, you will access Help information on using the Annual 
Reauthorization Narrative.  

 
 

Closing and Minimizing the Annual Reauthorization Narrative  

You can close the Annual Reauthorization Narrative by clicking on the File drop down 
menu and selecting Close. Alternatively, you can click on the Close window button in 
the upper right hand corner of the Word document window. Either method will save the 
narrative to the CONNECTIONS database and return you to the Annual 
Reauthorization Narrative tab with the Retrieve/Edit Narrative button visible.  

 
 

Rather than closing the document, you can minimize it using the Minimize button in the 
upper right hand corner of the Word document window.  

To re-open a minimized document, click on either the document’s Task Bar button at the 
bottom of the screen or the Retrieve/Edit button on the Annual Reauthorization tab. 

Note: Be sure to save your narrative before minimizing since minimizing does not save 
your work. 
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3i – FAD Checklist Tab 
 

 
 

The FAD Checklist tab provides a tool for recording and verifying that all necessary 
tasks for proper certification and authorization of Foster and Adoptive Homes have been 
completed. 

The tab contains two sets of entries: The first displays tasks required in the FAD 
Application process. The second displays tasks for the Home Study process. Following 
each task is a field in which completion dates can be directly entered by clicking and 
typing in the field. This allows workers to record the timeline of their progress through the 
FAD development process. 

Buttons 

Save: Saves entered dates to the CONNECTIONS database. Only enabled if dates 
have been entered or changed. 

Cancel: Cancels entered dates without saving them. Only enabled if dates have been 
entered or changed. 

Additional checklists for components of the FAD development process are available 
through buttons that appear at the bottom of the FAD Checklist tab. These are the 
Emergency, Reauth/Renewal, and Additional Items buttons. 

Emergency:  Clicking this button opens a separate window containing a checklist of 
tasks required to open an Emergency Foster home. As on the main checklist tab, each 
task is followed by a field for entering or updating completion dates.  
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Reauth/Renewal: Clicking this button opens a separate window containing a checklist 
of tasks specific to completing a Reauthorization or Renewal of a home. As on the main 
checklist tab, each task is followed by a field for entering or updating completion dates. 
Note: This button is disabled when the FRS is accessed via the Home Study Task. 

Additional Items: Clicking this button opens a separate window containing a blank 
checklist. Any tasks not listed on any of the previous checklists can be entered here. As 
on the main checklist tab, each task is followed by a field for entering or updating 
completion dates. 

The Emergency, Reauth/Renewal, and Additional Items windows each include Save and 
Cancel buttons, each of which returns you to the FAD Checklist tab. 

 

3j - Contacts Tab 
 

 
With the introduction of the FAD Record Summary process, the FRS becomes the 
primary mechanism for the creation and updating of Contact information. The Contacts 
tab provides a single place to enter information on all contacts made for a home. The 
Contacts information is the contemporaneous record for the home. It is meant to be 
continually updated throughout the FAD process. All contacts should be recorded in the 
FRS Contacts tab. 
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The single grid visible on the tab itself lists the following for each contact: Date/Time 
Recorded, Contact Date, Contacted By, Method, Purpose, and Location.  

 

Buttons 

Contacts are added, updated, and deleted through the use of three buttons that appear 
at the bottom of the tab: Add New, Contact Details, and Delete. 

Add New: Clicking this button opens a blank Contacts template for entering a new 
contact. 

Contact Details: This buttons opens an existing home contact to allow the updating of 
details and recording of additional comments. Contact Details can be edited up to the 
point that the FRS is approved and frozen. To access an existing contact: 

1. Select the contact you wish to update by clicking on its row in the grid on the 
Contacts tab. 

2. Click the Contact Details button at the bottom of the tab. 

 

• Information is entered on the Contacts window by typing, through the use 
of drop-down lists, or with checklists. 

• The Contacts window includes a Save button and a Cancel button, each 
of which returns you to the Contacts tab. 

Delete: This button deletes a contact. As with the Contact Details button, you must first 
select a contact by clicking its row in the grid on the Contacts tab. The Delete button will 
be disabled if the selected contact is part of an FRS that has already been approved and 
frozen. 
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The Fad Checklist, Contacts and the Home Study 

Keep in mind that, unless you are within the 90 day reauthorization period, you must 
enter the FRS via the Home Study task on the (Task List) in order to use the FAD 
Checklist, or create and update Contacts information. Doing so either accesses an in-
process home study or creates a new home study. If the FRS is being used to 
continually update Contacts information as it was designed to do, there will always be an 
in-process home study for the home. This becomes a factor in the Reauthorization 
process. (See “The FAD Recording Process Using the FRS – Annual Reauthorization” 
on page 41.) 

 

4 - FRS Online Help 
Context sensitive help information is available for all elements of the FRS including tabs, 
grids, buttons, and individual fields. Click on an element to make that element “active” 
and press the F1 key on your keyboard. Information about that element of the FRS will 
be displayed.  

Please note that F1 will not activate FRS Help when you are viewing the Home Study or 
Annual Reauthorization narratives. Help for these documents is available through the 
Help On Narratives button. 

The FRS Help system looks quite different and has more features than the Help in 
CONNECTIONS that has been available in the past. FRS On Line Help includes the 
following features: 

• A Table of Contents allowing access to all Help information. 

• Index and Search functions provide alternate means of finding information. 

• Interactive graphic examples of FRS elements. Clicking on certain portions of a 
graphic within FRS On Line Help will open explanations of that element. (Available 
Summer 2002.) 

• Hyperlinks appear throughout the Help information. These links will take you directly 
to related information such as definitions and procedural guidelines. 

When you press F1, you will open the FRS Help system. Information specific to the FRS 
element that was active when you pressed F1 will be displayed. Once you are in the 
Help system, the table of Contents allows you to have access to help information on 
other elements of FRS. 
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Besides context sensitive help information on FRS elements such as fields, tabs, and 
buttons, the FRS Help system includes the following: 

FRS Overview 

• A high level summary of the FRS including a listing of its features and functions. 

This overview can be accessed directly by clicking the word Help that appears in 
the upper left corner of the FRS window and then clicking on FRS Help which 
appears in the small drop-down menu. 

 
 

 “How Do I?” Help  

• Information on how to navigate within the FRS and how to best utilize its 
functions. 

Glossary (Available Summer 2002) 

• Definitions of terms commonly used in FAD casework 

• Definitions of FRS elements and concepts 

Guidelines  (Available Summer 2002) 

• Background on the legal, policy, and procedural guidelines followed by FAD 
workers as they develop and record the information viewed in the FRS. 
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Help on Help 

• Instructions on how to use the FRS Online Help system. 

Key elements of the information in this job aid relating to features and functionality of the 
FRS can also be found in the FRS Online Help. 

5 - Printing the FRS 
Printing in the FAD Record Summary is done through the Generate Report button that 
appears at the bottom of the FRS window.  

 
 

Clicking this button opens the Generate Report window.  

 
 

In the Generate Report window you can click the “All Tabs” checkbox to print all the 
information in the FRS, or you can choose to print the information from any of the 
individual tabs by clicking the checkboxes for those tabs. 
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After selecting the tabs you wish to have printed, clicking the Okay button opens the 
report in Adobe Acrobat Reader. Clicking on the Print button opens the Print window. 
Click on the OK button on the Print window to print the report. All selected information 
will be printed in a formatted report. Click on the Close button to return to the Generate 
Report window. 

 

IV – The FAD Recording Process Using the FRS 

The FRS provides a comprehensive view of FAD information that has been entered into 
CONNECTIONS, including home demographics, person detail and licensing information.  
In addition, the FRS is now the primary tool for the creation and updating of Home Study 
and Annual Reauthorization narratives, neither of which were previously captured in 
CONNECTIONS. The FRS is also used to record and manage Contacts information. 

The introduction of the FRS involves some new procedures for accessing FAD 
information and creating and updating Home Study and Annual Reauthorization 
narratives. 

This section will describe details concerning access to the FRS, using the FRS to 
complete a Home Study or Annual Reauthorization or enter Contacts information, and 
the events generated by this process.   

As was described earlier, the FAD Task List now includes three tasks for accessing the 
FRS: Home Study, Annual Reauthorization and View FAD Record Summary. 
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1 - Home Study  

• This task provides access for viewing information for the home and updating 
some of that information, as well as the ability to create and update Home Study 
narratives and Contacts information. 

If you select the Home Study Task from the Task List… 

In the following 
circumstances… 

Buttons 
Enabled State of FRS 

No Previous 
Home Study 

exists 
New 

FRS contains current data from database. 

 Narratives and comment boxes are blank. 

In-process Home 
Study exists Detail 

FRS contains current data from database. 

 Narratives and comment boxes contain in-
process version. 

New * 
FRS contains current data from database. 

 Narratives and comment boxes are blank. Approved/frozen 
Home Study 

exists Use 
Prior** 

FRS contains current data from database. 

 Narratives and comment boxes contain 
info from most recent saved FRS. 

 

* Clicking New when a previous Home Study exists will produce the following message: 

“Start with new (blank) narratives instead of those last saved?” 

• Clicking Continue will retrieve the FRS with blank narratives. Clicking 
Cancel returns you to the Task List. 

• ** This is a new button on the Task List window. 

•  

The FRS Initial Home Study Process 

The initial Home Study is required as part of opening a home. To complete this task 
using the FRS: 

1. Select Home Study on the FAD Task List.  The New button will be enabled.  

2. Clicking the New button opens a new FRS for the home. Data fields in the FRS 
will contain information drawn from the CONNECTIONS database. The Home 
Study and Annual Reauthorization narratives will contain blank templates.  All 
comment boxes will be blank. 
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3. Click the Home Study Narrative tab. 



 

4. On the left side of the tab, select Initial Home Study by clicking the checkbox.  

5. Click the Save button at the bottom of the list to save the Home Study Reason to 
the database. 

6. On the right side of the tab, select which narrative template you’ll be using by 
clicking the appropriate checkbox. You can choose from the Standard and 
GPS/MAPP versions. The Agency Home Study is not available in this phase of 
implementation. 

7. Click the Retrieve/Edit button. 

8. A blank copy of the selected template will open. Enter your home study 
information into the narrative. 

9. Save and close the narrative as described in “Additional Features of the FRS” on 
page 48. 

10. Exit the FRS by clicking the Close button in the bottom right-hand corner of the 
FRS window.  

• Closing the FRS after creating an Initial Home Study will generate a 
Home Study event with a status of PROC. Selecting this event and 
clicking the Detail button on the Event List will access the FRS in view-
only mode.  

• Once an in-process FRS (with its Initial Home Study) has been created 
(as described above), the home study can be completed in increments 
before it is  “Save and Submit”-ed.  

You can continue your work on that Home Study by selecting the Home 
Study task on the Task List, and clicking the Detail button. The “in-
process” FRS will open with its narratives and comment boxes containing 
your last saved entries.  

• Accessing the FRS via the View FAD Record Summary task allows 
view-only access to the “in process” FRS. 

11. When you have completed the Home Study narrative and entered all other 
necessary information, initiate the submission of the Home Study to your unit 
supervisor by clicking the Submit button in the bottom left-hand corner of the 
FRS window.  

12. Clicking the Submit button opens the Maintain License window. Here you can 
make any other necessary changes to the home’s licensing information. When 
these changes have been completed, you can: 

• Select File > Save and continue working, or  

• Change the home status to Pending Acceptance and Select File >Save 
and Submit to submit the home for supervisor approval.  The Home Study 
event and the Home License window are bundled into a single 
submission for supervisor approval.  A single To-Do task is generated. 
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13. Complete the To-Do window. 

Note: When the FRS and Home Study have been “save and submit”-ed, the status of 
the Home Study and Home License events change from PROC to PEND. 

 

Supervisor Approval 

1. When a supervisor receives an approval To-Do for the FRS, selecting the 
approval To-Do and clicking the Navigate button in the To-Do window will open 
the FRS in view-only mode. 

• A supervisor can also view the FRS at any time in a browse only mode 
by navigating from the pending Home Study event or via the View FAD 
Record Summary task. 

2. When the Home Study is approved: 

• The status of the Home Study event changes from PEND to APRV. 

• All information in the FRS is frozen. Selecting that Home Study event 
from the Event List and clicking the Detail button opens the frozen “Home 
Study” document in view-only mode for viewing or printing. 

• A Home License event with a status of APRV will be created. 

• An alert is sent to the worker reminding him/her that a current home 
certification or approval letter should be printed. 

Note: If the supervisor rejects the pending approval, the status of the FRS event 
becomes REJT.  The Description/Notes box on the To-Do Detail for the REJT event 
contains the reasons for the rejection. Accessing the FRS through the Home Study task 
opens the FRS, allowing the reasons for the supervisor’s rejection to be addressed. 

 

The FRS Interim Home Study Process 

The FRS Interim Home Study is conducted when the home has undergone any of the 
following changes that do not effect the home’s “from/to” certification dates:  

• Change in Marital Status 

• Change in Household Composition 

• Change in Home Address 

• Change in Capacity 

• Change in Level of Care 

• Change in Program Type 

• Change in Age Range or Gender 
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• Criminal Records Results 

Note: The Interim Home Study process replaces the Interim Reauthorization process 
that was previously performed in situations such as those listed above.  

 

To complete this task using the FRS: 

1. Select the Home Study task from the FAD Task List. If an approved/frozen 
Home Study exists (which should be the case if you are starting an Interim 
Home Study), both the New and Use Prior buttons will be enabled.   

• Clicking the New button will open the FRS with all data fields pre-filled 
with current information from the CONNECTIONS database.  The Home 
Study and Reauthorization narratives will contain blank templates and all 
comment boxes will be blank. Information can be entered in the Home 
Study narrative and comment boxes. 

• Clicking the Use Prior button will open the FRS with all data fields pre-
filled with current information from the CONNECTIONS database.  The 
Home Study and Reauthorization narratives and all comment boxes will 
contain information from the latest approved/frozen FRS. The Home 
Study narrative and comment boxes can be modified or added to as 
necessary. 

2. Click the Home Study Narrative tab. 

3. On the left side of the tab, click the checkbox (or boxes) that correspond(s) with 
the reason(s) you are conducting the Interim study.  

4. Click the Save button at the bottom of the list to save the Home Study 
Reason(s) to the database. 

5. On the right side of the tab, select which narrative template you’ll be using by 
clicking the appropriate checkbox. You can choose from the Standard and 
GPS/MAPP versions. The Agency Home Study is not available in this phase of 
implementation. 

6. Click the Retrieve/Edit button. 

• If you entered the FRS by clicking the New button on the Task List, the 
Home Study will be blank, allowing you to start a new narrative. 

• If you entered the FRS by clicking the Use Prior button on the Task List, 
the latest approved/frozen Home Study will open. You can modify or add 
to it as necessary. 

7. Enter your home study information into the narrative. Include an explanation of 
why the interim Home Study is being conducted. 

• Any previous Annual Reauthorization narrative is available in view-only 
mode for copying and pasting when completing a Home Study. 
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8. Save and close the narrative as described in “Additional Features of the FRS” 
on page 48.  

9. Exit the FRS by clicking the Close button in the bottom right-hand corner of the 
FRS window.  

• Closing the FRS after creating an Interim Home Study will generate a 
Home Study event with a status of PROC. Selecting this event and 
clicking the Detail button on the Event List will access the FRS in view-
only mode.  

• Once an in-process FRS (with its Interim Home Study) has been created 
(as described above), the home study can be completed in increments 
before it is  “Save and Submit”-ed.  

You can continue your work on that Home Study by selecting the Home 
Study task on the Task List, and clicking the Detail button. The “in-
process” FRS will open with its narratives and comment boxes containing 
your last saved entries.  

• Accessing the FRS via the View FAD Record Summary task allows 
view-only access to the “in process” FRS. 

10. When you have completed the Home Study narrative and entered all other 
necessary information, initiate the submission of the Home Study to your unit 
supervisor by clicking the Submit button in the bottom left-hand corner of the 
FRS window.  

11. Clicking the Submit button opens the Maintain License window. Here you can 
make any other necessary changes to the home’s licensing information such as 
changing the home’s status to Pending Acceptance. When these changes have 
been completed, you can: 

• Select File > Save and continue working, or  

• Change the home status to Pending Acceptance and Select File > Save 
and Submit to submit the home for supervisor approval.  The Home Study 
event and the Home License window are bundled into a single 
submission for supervisor approval.  A single To-Do task is generated. 

12. Complete the To-Do window. 

Note: When the FRS and Home Study have been “save and submit”-ed, the status of 
the Home Study and Home License events change from PROC to PEND. 
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Supervisor Approval 

1. When a supervisor receives an approval To-Do for the FRS, selecting the 
approval To-Do and clicking the Navigate button in the To-Do window will open 
the FRS in view-only mode. 

• A supervisor can also view the FRS at any time in a browse only mode 
by navigating from the pending Home Study event or via the View FAD 
Record Summary task. 

2. When the Home Study is approved: 

• The status of the Home Study event changes from PEND to APRV. 

• All information in the FRS is frozen. Selecting that Home Study event 
from the Event List and clicking the Detail button opens the frozen “Home 
Study” document in view-only mode for viewing or printing. 

• A Home License event with a status of APRV will be created.  

• An alert is sent to the worker reminding him/her that a current home 
certification or approval letter should be printed. 

Note: If the supervisor rejects the pending approval, the status of the FRS event 
becomes REJT. The Description/Notes box on the To-Do Detail for the REJT event 
contains the reasons for the rejection. Accessing the FRS through the Home Study task 
opens the FRS, allowing the reasons for the supervisor’s rejection to be addressed. 

•  
Entering Contacts Information in the FRS 

Contacts information should be continually entered and updated throughout the FAD 
process. To complete this task using the FRS: 

1. Select Home Study on the FAD Task List.  

2. You can use either the New or Use Prior buttons to open the FRS. The Contacts 
information will always contain all previously entered and saved information. 

3. Click the Contacts tab. 

4. If you are entering information about a new contact, click the New button. If you 
are updating information for a previous contact, click on the line of the grid 
representing that contact, then click the Contact Detail button. Clicking either 
button opens the Contacts sub-window. 

5. Enter your information in the Contacts sub-window. Some information is entered 
by typing directly in fields. Other information is entered using checkboxes or 
drop-down lists. 

6. Click the Save button to save your information to the database or click the 
Cancel button to return to the Contacts tab without saving your work. 
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7. Exit the FRS by clicking the Close button in the bottom right-hand corner of the 
FRS window. 

• If there was no in-process home study when you started this process, 
closing the FRS after entering Contacts information will generate a  Home 
Study event with a status of PROC. Selecting this event and clicking the 
Detail button on the Event List will access the FRS in view-only mode.  

• Once an in-process FRS has been created (as described above), you can 
enter and update more contacts information by selecting the Home Study 
task on the Task List, and clicking the Detail button. The “in-process” 
FRS will open. 

•  Accessing the FRS via the View FAD Record Summary task allows 
view-only access to the “in process” FRS. 

Note: All contacts entered in the FRS are carried forward into subsequent FRSs. This 
provides a readily available comprehensive record of all contacts with the home. 

 

2 - Annual Reauthorization  
This task provides access for viewing information for the home and updating some of 
that information, as well as the ability to create and update Annual Reauthorization 
narratives. It replaces the Reauthorization task that previously appeared on the Task 
List. 

Notes:  

• The Annual Reauthorization Task is only available on the Task List during the 
90 days prior to the home’s certification or approval due date. At all other times, 
all pushbuttons on the Task List are disabled when the Annual Reauthorization 
task is selected. 

• If the FRS is accessed via the Home Study task (using the Use Prior button), the 
Annual Reauthorization tab will open the last saved Annual Reauthorization 
document in view-only mode. 

 

The FRS Annual Reauthorization Process 

The FRS Annual Reauthorization is conducted at the end of a home’s annual 
certification period or when the home has undergone any changes that affect the home’s 
“from/to” certification dates.  
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To complete this task using the FRS: 

1. Select the Annual Reauthorization task from the FAD Task List. The button 
used to open the FRS from the Task List window and the state of the narratives 
and comment boxes will depend on the existence of previous or in-process 
Home Study and Reauthorization narratives. These dependencies are described 
in the following 2 charts: 

 

If no in-process Home Study exists                               
and you select the Annual Reauthorization Task from the Task 

List… 

In the following 
circumstances… 

Buttons 
Enabled State of FRS 

No Previous 
Reauth exists New 

FRS contains current data from database. 

 Narratives and comment boxes are blank.  

In-process 
Reauth exists Detail 

FRS contains current data from database. 

 Most recent saved Home Study narrative 
and comment boxes are opened. 

In-process Reauth narrative is opened. 

New (A) 

FRS contains current data from database. 

Most recent saved Home Study narrative 
and comment boxes are opened. 

Reauth narrative is blank. Approved/frozen 
Reauth exists 

Use 
Prior 
(B) 

FRS contains current data from database. 

Most recent saved narratives and 
comments boxes is opened. 

 

(A) Clicking New when a previous Reauthorization exists will produce the 
following message: 

“Start with new (blank) narratives instead of those last saved?” 

• Although the plural is used, in this instance, this message refers only 
to the Reauthorization narrative. 

• Clicking Continue will retrieve the FRS with a blank Reauthorization 
narrative. Clicking Cancel returns you to the Task List.  

(B) This is a new button on the Task List window. 
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If an in-process Home Study exists                               
and you select the Annual Reauthorization Task from the Task 

List… 

In the following 
circumstances… 

Buttons 
Enabled State of FRS 

No Previous 
Reauth exists 

Detail 
(A) 

FRS contains current data from database. 

Most recent saved Home Study narrative is 
opened. 

 Reauth narrative and comment boxes are 
blank.  

New (C) 

FRS contains current data from 
database. 

Most recent saved Home Study 
narrative is opened.  

Reauth narrative and comment 
boxes are blank. 

Approved/frozen 
Reauth exists 

 

Detail 
(B) 

Use 
Prior 
(D) 

FRS contains current data from 
database. 

Most recent saved narratives 
and comments boxes is 

opened. 

 

Note: You cannot have two simultaneous in-process FRSs. If there is an in-process 
Home study, an in-process Reauth cannot exist. 

(A) Clicking the Detail button opens the following message: 

“In-process Home Study exists and will be converted. Continue?” 

• Clicking Yes will convert the in-process Home Study FRS to an 
Annual Reauthorization FRS. The FRS will open as described in the 
first row of the chart above. 

• Clicking No will return you to the Task List. Since the in-process 
Home Study was not converted, you must complete, save, and submit 
the Home Study before being able to work on the Annual 
Reauthorization.  

(B) Clicking the Detail button opens the following message: 

“In-process Home Study exists and will be converted. Continue?” 
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• Clicking Yes will convert the in-process Home Study FRS to an 
Annual Reauthorization FRS. You will be returned to the Task List 
with the New and Use Prior buttons enabled. Which of these buttons 
you use to access the FRS determines how the FRS will open. 

• Clicking No will return you to the Task List. Since the in-process 
Home Study was not converted, you must complete, save, and submit 
the Home Study before being able to work on the Annual 
Reauthorization. 

(C) Clicking New when a previous Reauthorization exists will produce the 
following message: 

“Start with new (blank) narratives instead of those last saved?” 

• Although the plural is used, in this instance, this message refers only 
to the Reauthorization narrative. 

• Clicking Continue will retrieve the FRS with a blank Reauthorization 
narrative. Clicking Cancel returns you to the Task List.  

(D) This is a new button on the Task List window. 

 

2. The FRS will open and the Annual Reauthorization Narrative tab will be active. 

3. Although you will see choices for both an OCFS Standard Annual 
Reauthorization narrative and an Agency Annual Reauthorization, the latter 
choice is not available in this phase of implementation. The OCFS narrative will 
be automatically selected when the tab is opened. 

4. Click the Retrieve/Edit button. 

5. Enter new information or edit existing information in the narrative. 

6. Save and close the narrative as described in “Additional Features of the FRS” on 
page 48. 

7. Exit the FRS by clicking the Close button in the bottom right-hand corner of the 
FRS window.  

8. Closing the FRS after creating an Annual Reauthorization will generate an 
Annual Reauthorization event with a status of PROC. Selecting this event and 
clicking the Detail button on the Event List will access the FRS in view-only 
mode.  

• Once an in-process FRS (with its Annual Reauthorization) has been 
created (as described above), you can continue your work on that Annual 
Reauthorization by selecting the Annual Reauthorization task on the 
Task List, and clicking the Detail button. The “in-process” FRS will open 
with its narratives and comment boxes containing your last saved entries.  
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• Accessing the FRS via the View FAD Record Summary task allows 
view-only access to the “in process” FRS. 

9. When you have completed the Annual Reauthorization narrative and entered all 
other necessary information, initiate the submission of the Annual 
Reauthorization to your unit supervisor by clicking the Submit button in the 
bottom left-hand corner of the FRS window.  

10. Clicking the Submit button opens the Home License window. Here you can 
make any other necessary changes to the home’s licensing information such as 
changing the home’s status to Pending Acceptance.  

11. Be sure to click the Reauthorization checkbox on the Home License window. 

 
 

12. When these changes have been completed, you can: 

• Select File > Save and continue working, or  

• Change the home status to Pending Acceptance and Select File > Save 
and Submit to submit the home for supervisor approval.  The Annual 
Reauthorization event and the Home License window are bundled into a 
single submission for supervisor approval.  A single To-Do task is 
generated. 

13. Complete the To-Do window. 

Notes: 

• Attempting to Save and Submit without clicking the Reauthorization checkbox 
will produce the following message: 

“Check Reauthorization checkbox when submitting license for recertification.” 
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• When the FRS and Annual Reauthorization have been “save and submit”-ed, the 
status of the Annual Reauthorization and Home License events change from 
PROC to PEND. 

Supervisor Approval 

1. When a supervisor receives an approval To-Do for the FRS, selecting the 
approval To-Do and clicking the Navigate button in the To-Do window will open 
the FRS in view-only mode. 

• A supervisor can also view the FRS at any time in view-only mode by 
navigating from the pending Annual Reauthorization event or via the View 
FAD Record Summary task. 

2. When the Annual Reauthorization is approved: 

• The status of the Annual Reauthorization event changes from PEND to 
APRV. 

• All information in the FRS is frozen. Selecting that Annual Reauthorization 
event from the Event List and clicking the Detail button opens the frozen 
Annual Reauthorization document in view-only mode for viewing or printing.  

• A Home License event with a status of APRV will be created.  

• The “From” and “To” dates on the Home License window update to reflect the 
new certification or authorization period. 

• An alert is sent to the worker reminding him/her that a current home 
certification or approval letter should be printed. 

Note: If the supervisor rejects the pending approval, the status of the FRS event 
becomes REJT. The Description/Notes box on the To-Do Detail for the REJT event 
contains the reasons for the rejection. Accessing the FRS through the Annual 
Reauthorization task opens the FRS, allowing the reasons for the supervisor’s rejection 
to be addressed. 

 

3 - View FAD Record Summary 
This task provides view-only access to CONNECTIONS information for the home as well 
as any existing Home Study or Annual Reauthorization narratives. 

Note: This task opens an in-process FRS in view-only mode. 
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If you select the View FAD Record Summary Task from the Task List… 

In the following 
circumstances… 

Buttons 
Enabled State of FRS 

No FRS exists None This Task is only available when there is 
an in-process version of the FRS. 

In-process FRS 
exists Detail 

FRS contains current data from database. 

 Narratives and comment boxes contain 
latest saved version. 

 

4 - Events Created by the FRS  
The FRS process creates two navigable events: Home Study and Annual 
Reauthorization.  

Note: These events provide view-only access to the FRS. 

Conditions for status changes to these events are listed below: 

Event has status listed at right when… 

You select a Home Study or Annual 
Reauthorization task from the Task List,  

and 
Enter and save information in FRS data fields, 

comment boxes, or one of the narratives, 
and 

Click the Close or Submit buttons. 

PROC * 

You select a Home Study or Annual 
Reauthorization task from the Task List,  

and 
Enter and save information in FRS data fields, 

comment boxes, or Home Study narrative, 
and 

Click the Submit button, 
and 

Save and Submit the Home License window, 
and 

Complete the To-Do window. 

PEND * 

Your supervisor approves the PEND event. APRV ** 

Your supervisor rejects the PEND event. REJT * 

* PROC, PEND, and REJT events provide view-only access to that FRS. 
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** APRV events provide access to frozen Home Study or Annual Reauthorization 
documents for review or printing. 

Note: When a home is system-closed any in-process FRS events are converted to a 
status of COMP. These events are converted back to PROC status if the home is re-
opened. Data and narratives that were entered into the FRS before the system-closure 
are still available when the home is re-opened by clicking the Detail button on the Task 
List. 

 

The format of the frozen Home Study and Annual Reauthorization Documents 

Frozen Home Study and Annual Reauthorization documents are created when the FRS 
is approved.  Frozen documents are associated with their approval events and can be 
printed at any time.   

These documents are formatted in two parts:  

Part 1 is the formal document, which is given to the foster parents. 

Part 2 contains supporting information such as worker/contacts notes, supervisor 
comments, and the FAD checklist. This part is not given to the foster parents.   

 

V – Additional Features of the FRS 

Saving your work 

One of the most valuable habits you can develop in relation to working with Word 
documents such as the Home Study and Annual Reauthorization narratives is to save 
your work. The CONNECTIONS Citrix servers will “time out” a connection to the system 
that has been idle for 30 minutes. Any narratives that are open will be closed down 
without saving, so only work you had saved will appear in the narrative the next time it is 
opened. To make sure that a document closed by a “time out” contains all the work 
you’ve done on it, be sure to save the narrative on which you are working if you are 
interrupted by a phone call or meeting. Also, be sure to periodically save while working 
on lengthy documents. 

Remember, Word is set to periodically “AutoSave” your document. Every three minutes, 
your machine will automatically save whatever changes you’ve made to the document. 
These changes are made to an alternate copy of your document (known as an 
autorecover document) that is intended for use if your original document is damaged or 
lost. The autorecover document is a safety net. Do not depend on this function as the 
only protection for your work. If you need to access an autorecover document, contact 
the CONNECTIONS Helpdesk (1-800-NYS-1323). 

The autorecover document will only be recoverable for 240 hours (10 calendar days), so 
it is important to call the Help Desk as soon as possible with information about what 
document you were working on and when you timed out. 
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The procedure for saving narratives in the FRS is very similar to that for the rest of 
CONNECTIONS:   

1. Close the narrative using File > Close or the Close button.  

2. You will see the following message: 

“Save Changes?” 

3. You can click the Retrieve/Edit Narrative button to reopen the narrative and 
continue working on the narrative. 

When you close a narrative that you have accessed in view only mode, closing that 
document will not result in seeing these Save reminders. 

Additional Features in Word 

As you use the Word templates in the FRS to create the Home Study and Annual 
Reauthorization narratives, you will find that there are several features available in Word 
in the FRS that are not available when using word in CONNECTIONS. 

Included among these new features are Spell Check, Grammar Check, and Auto-
Correction. Spell Check will underline spelling errors in your document, allowing you to 
easily identify and correct them. Grammar Check will do the same for grammatical 
errors.  Auto Correction will automatically correct common misspellings.  For instance, if 
you mistakenly type “t-e-h”, Auto-Correction would automatically change it to “t-h-e” 
without you having to take any action. 

Copy and Paste Guidelines  

While the FRS now provides the primary mechanism for recording narratives such as the 
Home Study and Annual Reauthorization, there may be some instances in which you 
need to copy and paste information from other documents such as a Pre-Build 15 
converted Home Study narrative found in CONNECTIONS or a locally created narrative 
that was created outside of CONNECTIONS.  Additionally, you may need to copy and 
paste information from locally saved Word documents to one of the many comment 
boxes found in the FRS.   However, there are some elements of Word documents, which 
are described below, that may affect your ability to successfully copy and paste 
information from one Word document to another. 

The Home Study and Annual Reauthorization Word narratives located in either FRS or 
in CONNECTIONS prior to Build 15 are completed in templates. Templates can contain 
pre-formatted sections in which information is entered in designated text fields.  Sections 
of a template can be protected or unprotected.  If you’ve completed a Home Study 
narrative in a locally saved Word document, it may or may not be in the form of a 
template.  If you are not sure, you can check with staff in your own district or agency to 
determine if the locally created document contains protected fields. 

The unprotected areas on Word templates in CONNECTIONS are where you can enter 
information. These areas may display with a shaded background.  In the Home Study 
narrative in the FRS, shading is a simple means for you to tell where information can be 
entered. You can click at the beginning of a shaded area and begin typing in your text.  
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Also, if text exists in a shaded area, you can copy and paste that text from one section to 
another. 

The areas in Word templates that are protected serve as field labels and other 
instructional information.  These areas of a Word template are not shaded.  You cannot 
type over these areas, and copying and pasting these protected areas can prove 
problematic if not done properly.   

To help prevent problems copying and pasting between documents, keep in mind the 
following:  

• Whenever possible, type information directly in the Home Study and Annual 
Reauthorization templates contained in the FRS rather than creating these 
narratives outside of CONNECTIONS and copying and pasting from one 
document to another.  

• If it is necessary to record information outside of the FRS, use a blank MS 
Word document when possible.  Having a new Word document without pre-
formatted fields and labels will make copying and pasting into the FRS 
narratives easier.  

To Copy a Section of a CONNECTIONS Pre-Build 15 Converted Home Study or 
Reauthorization Narrative to the FRS. 

1. Select the CONVERTED Home Study or Reauthorization Narrative from the 
Event List. The Description for the Event is “Converted Pre Build 15 Home 
Study.”  

2. Click on the Detail button. 
The Output Launch window displays. 

3. Click on the Document button. 
The Converted Narrative opens in Microsoft Word.  

4. Highlight the section of the Home Study or Reauthorization Narrative that you 
wish to copy into the FRS Narrative.  Be sure to highlight only the text that 
was previously entered by a user.  Do not highlight the topic headings or 
instructions.  

5. Click on the Edit drop-down menu and select “Copy.” 

6. Click on the File drop-down menu and select “Close.” 

7. Access the Home Study or Reauthorization tab in the FRS. 

8. Scroll down to the section in the new Home Study or Reauthorization where 
you wish to enter the text.  

9. Click in the Gray (update) area of this section.  

10. Click the Edit drop-down menu and select “Paste.”  
The text should appear in the appropriate section. 
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To Copy more than one Section of a CONNECTIONS Pre-Build 15 Converted Home 
Study or Reauthorization Narrative to the FRS. 
To copy more than one text section of a CONNECTIONS Pre-Build 15 Converted Home 
Study narrative to the FRS, use Section XVII Other (Agency-Specific Items) as the 
location in the FRS Home Study narrative for pasting information.   Keep in mind that a 
straight copy and paste will result in protected text from the CONNECTIONS narrative 
being protected in FRS after it is pasted.  This makes the text difficult to work with and 
could clutter your FRS Home template with useless information. To avoid this problem, 
use the following method when copying and pasting from a CONNECTIONS Home 
Study narrative: 

1. Select the CONVERTED Home Study from the Event List. The Description 
for the Event is “Converted Pre Build 15 Home Study.”  

2. Click on the Detail button. 
The Output Launch window displays. 

3. Click on the Document button. 
The Converted Narrative opens in Microsoft Word.  

4. Highlight the portion of the Home Study that you wish to copy into the FRS 
Narrative.  

5. Click on the Edit drop-down menu and select “Copy.” 

6. Click on the File drop-down menu and select “Close.” 

7. Access the Home Study tab in the FRS.  

8. Scroll down to Section XVII.  

9. Click in the Gray (update) area of Section XVII.  

10. Click the Edit drop-down menu and select “Paste Special.”  
Note: you may have to click the down-arrow at the bottom of the list to 
expose this selection.  

11. Select “Unformatted Text.” 

12. If there is extraneous information, such as instructions or topic headings that 
was brought into the new document with the original copy and paste 
operation, this material should no longer be protected and can be deleted 
from the document. 

After a short time, your selected narrative text will paste into Section XVII of the FRS 
Home Study.  All pasted text will now be editable.  If desired, you can copy selected 
sections of the information from Section XVII of the FRS narrative into other sections of 
the FRS narrative to better organize your Home Study information.  Any materials that 
are not needed in the new Home Study (e.g., old section headings) are no longer 
protected and can be deleted.  To copy and paste into the new FRS Reauthorization 
document, you can follow the same steps and paste the material from the Pre Build 15 
Reauthorization document into the end of the FRS document and copy selected portions 
of the information into appropriate sections of the new Reauthorization document.   
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To Copy information from a separate Microsoft Word document into the FRS  

To copy information from a separate Microsoft Word document (e.g., a Home Study that 
was maintained outside of CONNECTIONS) into the FRS (Home Study tab), you can 
also use Section XVII of the FRS Home Study narrative as the location to paste the 
information. It is important to note that CONNECTIONS and the FRS are running in a 
Citrix session.  To access your locally saved Home Study document, you will need to 
switch to your local desktop.  To copy and paste from a locally saved Home Study Word 
narrative to the FRS Home Study narrative: 

1. Switch to your local desktop by pressing down the Alt key and pressing the 
Tab key until your local desktop session appears. 

2. Release the Alt and Tab keys. 

3. Open Word on your local desktop and open the Home Study Word narrative. 

4. Highlight the portion of the Home Study Word narrative that you wish to bring 
into the new Home Study. . 

5. Click the Edit drop-down menu and select “Copy.” 

6. Switch back to your Citrix session by pressing down the Alt key and pressing 
the Tab key until the Citrix session appears 

7. Release the Alt and Tab keys. 

8. Access the Home Study in the FRS. 

9. Scroll down to Section XVII. 

10. Click in the Gray (update) area of Section XVII. 

11. Click the Edit drop-down menu. 

12. If you have no protected fields in the document you are copying, select 
Paste.  If you do have protected fields, select Paste Special (Note: you may 
have to click the down-arrow at the bottom of the list to expose this 
selection). 

13. If you have selected Paste Special, click Unformatted Text. 
 

As with the copy and paste process from the CONNECTIONS Home Study narrative, 
after a short time, your selected Home Study narrative text will paste into Section XVII of 
the FRS Home Study. All pasted text will now be editable.  If desired, you can copy 
selected sections of the information from Section XVII of the FRS narrative into other 
sections of the FRS narrative to better organize your Home Study information.  If there is 
extraneous information, such as instructions or topic headings that was brought into the 
document with the original copy and paste operation, this material can be deleted from 
the document. 
You can copy information from your own documents into FRS comment boxes, but 
remember that special formatting (e.g., tab sets, fonts, styles) will be lost when you 
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paste copied text into an FRS comment box.  To avoid problems, keep the formatting of 
your source document as generic as possible. 

Modifying and Saving Documents with Enhanced Narrative Locking 

The FRS utilizes a feature called Enhanced Narrative Locking to aid in the updating of 
the Home Study and Annual Reauthorization narratives as well as the Safety 
Assessment.  

The purpose of Enhanced Narrative Locking is to allow workers to modify these 
documents with confidence that they will be able to save their work even if someone else 
was making their own separate modifications to that document at the same time. 

As an example of this new functionality, assume that two workers are modifying the 
Home Study narrative of a home simultaneously and Worker A is the first to save her 
revisions. Under the old functionality, Worker B would see a message telling him that his 
save had failed and all his updates would be lost. He would then have to open the 
narrative document again and start his modifications over from scratch. 

With Enhanced Narrative Locking, things work a little differently. Using the same 
example as above, when Worker B attempts to save his changes to the Home Study 
narrative after Worker A’s modifications have been saved, Worker B will see the 
following message: 

 

 
 

If Worker B clicks the Yes button, he will see the following message: 

 

 
 

It is important to note what narrative and time are listed in this message box.  
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Using this information, Worker B can find and open the locally saved version of the 
Home Study he was unable to save to the FRS earlier.  

To access the locally saved narrative:  

1. Click the Start button in the Citrix window. 

2. Select Local Save from the Start menu. 

 
 

3. The Local Save Documents submenu will open. It contains a list of all 
documents that have been saved locally by the system.  

4. Click on the title for the document you want to open. 

From the locally saved version, Worker B can then select and copy the information he 
wants to include in the narrative. By returning to the Home Study Narrative tab of the 
FRS, Worker B can open the Home Study narrative. Instead of having to type all his 
revisions all over again, he can paste his changes into the narrative. 

Note: The locally saved copy of your narrative will only be available for 240 hours (10 
calendar days) from when the Enhanced Narrative Locking feature created it. It is 
important to copy and paste your work from this version into the FRS narrative as soon 
as possible. 

The FRS Data Fix 

In order to provide workers with access to existing Home Study narratives created 
before the introduction of the FRS, the following data fix will be performed when the FRS 
is implemented: 

• Existing Home Study narratives for homes in Pending-Acceptance or Pending 
Emergency status will be placed into a Standard Home Study narrative in the 
FRS.  

• An FRS event in PEND status will be created for the supervisor to navigate to in 
order to approve these narratives. A list of these homes will be generated and 
sent to districts and agencies at implementation. 
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• Existing Home Study narratives for homes in all other statuses will be stored as 
“Converted Events” on the Event List. Workers can access these narratives via 
those events and copy and paste the narrative information into the appropriate 
FRS narrative sections. 
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